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	How do I convert Office 365 to PDF?
There are different ways to change Outlook 365 to PDF. Here, we'll explain the top 2 ways. You can choose the one that works best for you.

Convert Outlook 365 to PDF with "Save as PDF":


Open Outlook 365 on your computer.
Open the email you want to convert.
Click on the File button, then choose Print.
In the Printer options, select Microsoft Print to PDF.
Choose PDF as the file type in the dialogue box.
Click on Save.


Convert Outlook 365 to PDF with an Automated Solution:

Use a tool like Advik Office 365 Backup Software.
This tool can convert multiple Office 365 emails to PDF quickly and easily.
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	Silent Uninstall Switches for PDFArchitect 9
Hi all,
Is there a way to silently uninstall PDFArchitect 9, either via command line or through switches when using PDF_Architect_9_Installer.exe?
A bunch of company computers patched/updated PDFCreator recently and they've all had PDFArchitect installed along side it.
I'd like to use my management software to remove PDFArchitect, but cannot find any documentation on commands or switches to use to mass uninstall the program, otherwise I will need to remove it automatically.
Thank you.
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	PDF has Arial as font but Architect 9 doesn't recognise the Font
Have recently tried to batch find and replace a text string is multiple PDFs, the string is in Arial but Architect 9 changes the changed string to Nimbus (which looks like New Times Roman). Why does it not change the text string alone and not change the font and the same time.
Revu Bluebeam can do it why cant this?
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	How to Print Outlook Emails to PDF File?
Printing Outlook emails to a PDF file can be achieved through a straightforward process. First, open the email you wish to print within Outlook. Next, navigate to the "File" menu at the top-left corner of the Outlook window. From there, select the "Print" option. In the Print dialog box, you can choose the printer as "Microsoft Print to PDF" or any PDF printer software you have installed on your system. After selecting the PDF printer, adjust any printing settings as needed, such as page orientation or number of pages to print. Finally, click on the "Print" button to generate the PDF file of the Outlook email. Once the printing process is complete, you'll be prompted to specify the location where you want to save the PDF file. Choose a suitable location, give the file a name, and click "Save." Your Outlook email will now be converted into a PDF file and saved to the designated location on your computer. If you are looking for a secure and instant solution to print Outlook emails to PDF, then you can use the Advik Outlook PST Converter tool on your Windows system. The solution will effortlessly print emails direct;y from your Outlook profile to PDF format along with attachments.
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	How to Convert EML to PDF in Bulk?
Advik EML to PDF Converter is a secure and reliable solution to convert EML to PDF format. It is specially designed for converting EML files to PDF format. The interface of this utility is very simple and easy to use. Both technical and non-technical users can easily use it without facing any issues. It can convert EML to PST in bulk.
teps to Convert EML to PDF With Attachments

Run this software on your system.
Add EML files and press Next.
Choose EML folder and hit on Next.
Select PDF as a saving option.
Browse target location and press Next.

Done!
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	Deactivate offline
Hi, our IT team activated one of our internal server which shouldn’t (offline activation) , is there a way to deactivate a PDFCreator terminal license offline? please help! Thank you!!
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	annotation Coordinate System error
When I tried to extract annotation positions and sizes by spire.pdf in the PDF generated by pdfcreator, I found that the coordinates were incorrect
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	Customer-portal
We have 2 license, one terminal and one professional for our users, but can only see one pdfcreator business’s(professional) license in our portal, how can I switch to another license?
Btw, we are using offline activation since we have internal network
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	How to Batch Export Outlook Email to PDF Files?
To export Outlook email to PDF files, you can use both manual and professional solution. You can manually save Outlook emails into PDF format via Print option. But, with this approach, you can export only one email at a time. If you have need to convert multiple Outlook emails to PDF then it takes lot of time to complete the process. However, with Advik PST to PDF Converter, you can batch export Outlook email to PDF files. No need to save each email over and over again.
Steps to Export Outlook Email to PDF in Bulk

Run this software on your system.
Choose Outlook profile.
Select required email folders and press Next.
Choose PDF as a saving option.
Browse target location and press Next button.

Done! That's how you can easily save Outlook emails in PDF format.
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	How to Export MSG Files to PDF Format?
To export MSG files to PDF format, you can follow several methods depending on your preferences and the tools available to you. One common approach is to utilize Microsoft Outlook, which allows for the conversion of MSG files to PDF directly within the application. To do this, open the MSG file in Outlook, then select "File" and choose "Save As." From the dropdown menu, select PDF as the file format and specify the location where you want to save the PDF file. Another option is to use specialized third-party software designed for file conversion. Many such tools are available online, offering batch conversion capabilities and additional features for customization. Simply search for "SysConverter for MSG" and choose a reputable tool that suits your needs. Additionally, if you're comfortable with programming or scripting, you can automate the conversion process using libraries or scripts in languages like Python. This approach may require a bit more technical expertise but offers flexibility and customization options tailored to your specific requirements. Overall, whether through Outlook, third-party software, or scripting, exporting MSG files to PDF format is achievable with the right tools and methods at your disposal.
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	Fusion pdf avec Ms Access en VBA
Bonjour,
Ma config : Access 2016, dernière version de PDF Creator sous Windows 11
Je rencontre un problème pour fusionner plusieurs pdf depuis le composant PDFcreator COM en vba.
Je créé mes fichiers pdf depuis acces dans un dossier, ensuite je lance la fusion de tous mes fichiers. La première fois tout fonctionne correctement mais si je relance le script sans quitter Access Pdfcreator prend qu'un fichier sur les 3 !
J'ai essayé d'intégrer la fonction DeleteJob mais elle plante le script !
Voici le code que j'utilise :
Private Sub bt_fusion2_Click()
    
On Error GoTo MyErrorHandler
 
    Dim fullPath As String
    Dim PDFCreatorQueue As Variant
    Dim printJob As Variant
    Dim oPDF As Variant
 
    Set PDFCreatorQueue = CreateObject("PDFCreator.JobQueue")
    Set oPDF = CreateObject("PDFCreator.PdfCreatorObj")  'PDFCreator.clsPDFCreator
 
    file1 = CurrentProject.Path &amp; "\Temp\facture.pdf"
    file2 = CurrentProject.Path &amp; "\Temp\CGV2024.pdf"
    file3 = CurrentProject.Path &amp; "\Temp\AttestationTVA.pdf"
 
    fullPath = CurrentProject.Path &amp; "\temp\" &amp; Me.txt_nompdffusion

    PDFCreatorQueue.Initialize
 
    DoCmd.Hourglass True  ' change pointeur sourie en sablier
    oPDF.AddFileToQueue file1
    oPDF.AddFileToQueue file2
    oPDF.AddFileToQueue file3
 
    MsgBox "Il y a " &amp; PDFCreatorQueue.Count &amp; " fichier(s) dans la file pour fusion."
 
    PDFCreatorQueue.MergeAllJobs
    Set printJob = PDFCreatorQueue.NextJob
    printJob.SetProfileByGuid ("DefaultGuid")

    MsgBox "PDFCreator va créer le fichier fusionné. Cela peut prendre quelques minutes pour de gros fichiers."
    DoCmd.Hourglass True  'change pointeur sourie en sablier
    printJob.ConvertTo (fullPath)
    DoCmd.Hourglass False 'change pointeur sourie en normal
 
    If (Not printJob.IsFinished Or Not printJob.IsSuccessful) Then
        MsgBox "Erreur de Création ! Impossible de fusionner les fichiers."
    Else
        MsgBox "Fichier fusionné créé avec succès. Opération terminée !", vbInformation
    End If
    PDFCreatorQueue.Clear
    PDFCreatorQueue.ReleaseCom
    
    Set PDFCreatorQueue = Nothing
    Set printJob = Nothing
    Set oPDF = Nothing
 
    Exit Sub
 
MyErrorHandler:
    PDFCreatorQueue.ReleaseCom
    Dim Msg As String
    Msg = "Error No " &amp; Err.Number &amp; ": " &amp; Err.Description
 
    If Err.Number = -2146233079 Then
        MsgBox Msg + " Vider la file, et redémarrer PDF Creator."
    Else
        MsgBox Msg
    End If
End Sub


Merci à tous pour l'aide.
Stéfen
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	Licensing service error
i have an error on starting licencing service af pdfcreator terminal server on server2016.
The error is initiate after move the Virtual Machine on another Host.
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	Erro Interleaved2of5
Quando imprimo o boleto utilizando o PDF Creator, ao abrir o boleto mostra esse erro e no lugar do código de barras aparecem várias bolinhas.
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	How to deactivate pdf terminal server lincense?
hi
i install pdf terminal server on the the wrong  windows server, could i  deactive pdf termianl server and install another one?
is there any way to solve this problem?
eric
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	Running PDFCreator Github Solution is giving "Can't find a supported Ghostscript installation"
I have downloaded the PDFCreator Solution from Github and after building the solution the program is giving: "Can't find a supported Ghostscript installation. Program exiting now".
Any support on how to resolve this issue is appreciated.
Thank you.
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	How to Export MBOX Emails in PDF File?
To export MBOX emails to a PDF file, you can use several methods. One common approach is to use an email client or specialized conversion software. Here's a step-by-step guide to using both methods:

Install Mozilla Thunderbird: If you don't have Thunderbird installed, download and install it on your computer.
Install MBOX to PDF Converter Add-on: In Thunderbird, go to "Tools" &gt; "Add-ons" and search for an MBOX to PDF converter add-on. One popular option is "ImportExportTools NG." Install the add-on to Thunderbird.
Import MBOX Files: In Thunderbird, go to "Tools" &gt; "ImportExportTools NG" &gt; "Import MBOX file." Select the MBOX file containing the emails you want to export.
Select Emails to Export: After importing the MBOX file, select the emails you want to export to PDF format.
Export as PDF: Right-click on the selected emails and choose "Export selected messages." Select "PDF file" as the export format and choose the destination folder where you want to save the PDF file.
Complete Export: Follow the prompts to complete the export process. Thunderbird will convert the selected emails to PDF format and save them to the specified location.

Method 2: Using Specialized Conversion Software:

Choose Conversion Software: Select a reliable Advik MBOX to PDF converter software. There are various options available online, both free and paid.
Install and Launch the Software: Download and install the chosen conversion tool on your computer.
Select MBOX Files: Open the conversion tool and select the MBOX files or folders containing the emails you want to export to PDF format.
Choose Output Format (PDF): Specify PDF as the output format for conversion.
Start Conversion: Initiate the conversion process and wait for the tool to convert the MBOX emails to PDF format.
Save PDF Files: Once the conversion is complete, save the converted PDF files to your desired location on your computer.

Using specialized conversion software is generally quicker and more convenient, especially for users with large amounts of data to convert. Choose the method that best suits your needs and preferences. Make sure to follow the instructions carefully to ensure a successful export of MBOX emails to PDF format.
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	Install PDF Creator
Greetings All.
When installing PDF Creator it also installs PDF Architect 9
Is PDF Architect 9 required or can it be removed
Many thanks
            1 post - 1 participant
            Read full topic
	Disable PDF Architect 9 Installer / Updater
Guten Tag
Wir haben PDF Architect 9 auf unserer VDI Umgebung installiert.
Nun poppt der Installer vom PDF Architect bei jedem Benutzer-Login auf.
Wie kann der Installer via GPO / Registry ausgeschaltet werden???
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	Multiple Printers
Greetings All
I want to set up multiple printers SALES / INVOICE / CREDIT on a stand alone machine with one user
Printer 1 SALES will use the Watermark file sales
Printer 2 INVOICE will use the Watermark Invoice
Printer 3 CREDIT will use the Watermark Credit
Is this possible or have i got it wrong
Regards
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	How to Save Apple Mail Emails in PDF File?
To effortlessly convert Apple Mail to PDF, try the Advik Email Backup Tool. However, if you want a manual way to save emails, then below is the solution for you. The built-in printing functionality in macOS can save Apple Mail emails as PDF files. Follow these steps to save Apple Mail emails as PDF files:

Open Apple Mail: Launch the Apple Mail application on your Mac.
Select Email(s): Navigate to the email you want to save as a PDF file. If you want to save multiple emails, hold down the "Command" key while selecting each email.
Print Email(s):


With the email(s) selected, go to the "File" menu at the top-left corner of the screen.
From the drop-down menu, select "Print" or use the shortcut "Command + P."


Choose PDF Option: In the Print dialog box that appears, look for the "PDF" button located in the lower-left corner. Click on it to reveal a drop-down menu.
Save as PDF: From the drop-down menu, select "Save as PDF." This option converts the selected email(s) into a PDF file.
Set Save Location: A "Save As" dialog box will appear, prompting you to choose a location to save the PDF file. Navigate to the desired folder on your computer and enter a name for the PDF file.
Save PDF: Once you've chosen the save location and entered a name for the PDF file, click on the "Save" button to save the email(s) as a PDF file.
Confirmation: After clicking "Save," macOS will convert the selected email(s) into a PDF file and save it to the specified location. You can then access the PDF file from the location where you saved it.

By following these steps, you can easily save Apple Mail emails as PDF files on your Mac, allowing you to store, share, or archive them conveniently in a widely compatible format.
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	How to Create PDF File for MBOX Emails?
How to Create PDF File fCreating a PDF file for MBOX emails can be accomplished through several methods. Here's a simple guide on how to do it:

Begin by selecting the MBOX emails that you want to convert into a PDF file. You can choose individual emails or multiple emails from your MBOX mailbox.
If you have an email client installed that supports MBOX files, such as Thunderbird or Apple Mail, you can open the MBOX file within the client and then use the print option to print the emails to PDF. Most email clients offer the ability to print emails, and you can choose the option to save as PDF instead of printing on paper.
e: Alternatively, you can use third-party software specifically designed for converting MBOX emails to PDF format. There are several tools available online that offer this functionality. You can search for a secure Advik MBOX to PDF converter, download and install it on your computer, and then follow the instructions to convert your MBOX emails to PDF.or MBOX Emails?
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	Error Code: 404 when installing Architect Pro 6
I am attempting to install PDF Architect Pro 6 and when I do I get a download error. I check the Error Details and it says "Error code: Can't download isntallation package. Error code: 404".
I know version 6 is old and I am guess the download pages it is connecting have been removed. Is there anything I can do? Is there a offline installer?
Thanks!
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	PDF Creator Server does not work after upgrade
Hello,
after upgrade PDF Creator Server from 2.4.2 to any version higher than 2.4.2, ghostscript crashes with following error message:
"[Error] pdfforge.PDFCreator.Conversion.Ghostscript.Conversion.GhostscriptConverter.DoConversion: There was an unexpected error while converting the Job C:\windows\TEMP\PDFCreator Server\Spool\6-7435FC5AC43F48538D35242EEB0FA095.inf: System.InvalidOperationException: Sequence contains no elements
at System.Linq.Enumerable.Single[TSource](IEnumerable`1 source)
at pdfforge.PDFCreator.Conversion.Ghostscript.GhostScript.CollectIntermediatePdfFile(Job job)
at pdfforge.PDFCreator.Conversion.Ghostscript.GhostScript.Run(OutputDevice outputDevice, String tempOutputFolder)
at pdfforge.PDFCreator.Conversion.Ghostscript.Conversion.GhostscriptConverter.DoConversion(Job job, ConversionMode conversionMode)
[Error] pdfforge.PDFCreator.Core.Workflow.JobRunner.RunJob: The job failed: Ghostscript execution failed (Conversion_GhostscriptError)
[Error] pdfforge.PDFCreator.Core.Workflow.ConversionWorkflow.RunWorkflow: Ghostscript execution failed
Conversion_GhostscriptError
"
Replaced ghostscript in folder "C:\Program Files\PDFCreator Server\Ghostscript" with version 0.9.95 from PDF Creator Server 2.4.2, PDF Creator Server works in any version above 2.4.2.
Any version of ghostscript above 0.9.56.1  crashes.
Is this an known issue ?
Kind regards
Inga
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	PDF Creator crash with 5.1.2 and 5.2.0 versions
Hello,
I have a problem with PDFCreator versions 5.1.2 and newer.
In summer I updated PDFCreator form 5.1.1.2  to 5.1.2 but when trying to print (even a test page for the default profile), the program crashes and after that it crashes after even starting the program. The same behavior is with version 5.2.0. Same problem on both my computers Windows 10 and Windows 11.
PDFCreator starts only after reinstaling, but crashes when trying to print.
I tried unistall and new install, with no change. I have to use now PDFCreator 5.1.1.2
Any suggestions anyone?
Error report:
Error Report for PDFCreator 

Exception:
System.InvalidOperationException
Sequence contains no elements
void ThreadHelper.ThreadStart() :
void SynchronizedThread.RunThread() :
void JobInfoQueueManager.ProcessJobs() :
void JobInfoQueueManager.ProcessJob(JobInfo jobInfo) :
WorkflowResult ConversionWorkflow.RunWorkflow(Job job) :
void ConversionWorkflow.PrepareAndRun(Job job) :
void InteractiveWorkflow.DoWorkflowWork(Job job) :
void ShellManager.ShowPrintJobShell(Job job) :
bool? Window.ShowDialog() :
object Window.ShowHelper(object booleanBox) :
void Dispatcher.PushFrameImpl(DispatcherFrame frame) :
IntPtr UnsafeNativeMethods.DispatchMessage(in MSG msg) :
IntPtr HwndSubclass.SubclassWndProc(IntPtr hwnd, int msg, IntPtr wParam, IntPtr lParam) :
object Dispatcher.LegacyInvokeImpl(DispatcherPriority priority, TimeSpan timeout, Delegate method, object args, int numArgs) :
object ExceptionWrapper.TryCatchWhen(object source, Delegate callback, object args, int numArgs, Delegate catchHandler) :
object ExceptionWrapper.InternalRealCall(Delegate callback, object args, int numArgs) :
object HwndSubclass.DispatcherCallbackOperation(object o) :
IntPtr HwndWrapper.WndProc(IntPtr hwnd, int msg, IntPtr wParam, IntPtr lParam, ref bool handled) :
IntPtr Dispatcher.WndProcHook(IntPtr hwnd, int msg, IntPtr wParam, IntPtr lParam, ref bool handled) :
void Dispatcher.ProcessQueue() :
void DispatcherOperation.Invoke() :
void CulturePreservingExecutionContext.Run(CulturePreservingExecutionContext executionContext, ContextCallback callback, object state) :
void CulturePreservingExecutionContext.CallbackWrapper(object obj) :
void DispatcherOperation.InvokeImpl() :
object ExceptionWrapper.TryCatchWhen(object source, Delegate callback, object args, int numArgs, Delegate catchHandler) :
object ExceptionWrapper.InternalRealCall(Delegate callback, object args, int numArgs) :
async void PrintJobShell.PrintJobShell_OnLoaded(object sender, RoutedEventArgs e) :
async Task InteractiveWorkflowManager.Run() :
IWorkflowViewModel WorkflowNavigationHelper.GetValidatedViewModel(IRegion region, string navigationUri) :
object WorkflowNavigationHelper.GetRawModel(IRegion region, string navigationUri) :
TSource Enumerable.First&lt;TSource&gt;(IEnumerable&lt;TSource&gt; source) :

Platform:
x64

Additional Data:
thread-name=ProcessingThread
product.edition=pdfcreator_free
product.name=PDFCreator Free
ui.language=sk

Log:
The resource assembly will be skipped: MahApps.Metro.IconPacks.MaterialDesign.resources
Trying to resolve assembly: MahApps.Metro.IconPacks.MaterialDesign.resources, Version=4.0.0.0, Culture=sk-SK, PublicKeyToken=0c0d510f9915137a
The resource assembly will be skipped: MahApps.Metro.IconPacks.MaterialDesign.resources
Trying to resolve assembly: MahApps.Metro.IconPacks.MaterialDesign.resources, Version=4.0.0.0, Culture=sk, PublicKeyToken=0c0d510f9915137a
The resource assembly will be skipped: MahApps.Metro.IconPacks.MaterialDesign.resources
Trying to resolve assembly: MahApps.Metro.IconPacks.MaterialDesign.resources, Version=4.0.0.0, Culture=sk, PublicKeyToken=0c0d510f9915137a
The resource assembly will be skipped: MahApps.Metro.IconPacks.MaterialDesign.resources
Update period has passed (set to: 1. 2. 2024 10:38:20)
Start UpdateCheck
New Version available
NextUpdate dated to 1. 2. 2024 10:38:20
Trying to resolve assembly: RssFeed.resources, Version=5.1.2.5, Culture=sk-SK, PublicKeyToken=fc6825f92a0342e2
The resource assembly will be skipped: RssFeed.resources
Trying to resolve assembly: RssFeed.resources, Version=5.1.2.5, Culture=sk-SK, PublicKeyToken=fc6825f92a0342e2
The resource assembly will be skipped: RssFeed.resources
Trying to resolve assembly: RssFeed.resources, Version=5.1.2.5, Culture=sk, PublicKeyToken=fc6825f92a0342e2
The resource assembly will be skipped: RssFeed.resources
Trying to resolve assembly: RssFeed.resources, Version=5.1.2.5, Culture=sk, PublicKeyToken=fc6825f92a0342e2
The resource assembly will be skipped: RssFeed.resources
Update period has passed (set to: 1. 2. 2024 10:38:21)
Trying to resolve assembly: MahApps.Metro.SimpleChildWindow.resources, Version=1.3.2.0, Culture=sk-SK, PublicKeyToken=bbbfdff7f500a992
The resource assembly will be skipped: MahApps.Metro.SimpleChildWindow.resources
Trying to resolve assembly: MahApps.Metro.SimpleChildWindow.resources, Version=1.3.2.0, Culture=sk-SK, PublicKeyToken=bbbfdff7f500a992
The resource assembly will be skipped: MahApps.Metro.SimpleChildWindow.resources
Trying to resolve assembly: MahApps.Metro.SimpleChildWindow.resources, Version=1.3.2.0, Culture=sk, PublicKeyToken=bbbfdff7f500a992
The resource assembly will be skipped: MahApps.Metro.SimpleChildWindow.resources
Trying to resolve assembly: MahApps.Metro.SimpleChildWindow.resources, Version=1.3.2.0, Culture=sk, PublicKeyToken=bbbfdff7f500a992
The resource assembly will be skipped: MahApps.Metro.SimpleChildWindow.resources
Trying to resolve assembly: MahApps.Metro.SimpleChildWindow.resources, Version=1.3.2.0, Culture=sk-SK, PublicKeyToken=bbbfdff7f500a992
The resource assembly will be skipped: MahApps.Metro.SimpleChildWindow.resources
Trying to resolve assembly: MahApps.Metro.SimpleChildWindow.resources, Version=1.3.2.0, Culture=sk-SK, PublicKeyToken=bbbfdff7f500a992
The resource assembly will be skipped: MahApps.Metro.SimpleChildWindow.resources
Trying to resolve assembly: MahApps.Metro.SimpleChildWindow.resources, Version=1.3.2.0, Culture=sk, PublicKeyToken=bbbfdff7f500a992
The resource assembly will be skipped: MahApps.Metro.SimpleChildWindow.resources
Trying to resolve assembly: MahApps.Metro.SimpleChildWindow.resources, Version=1.3.2.0, Culture=sk, PublicKeyToken=bbbfdff7f500a992
The resource assembly will be skipped: MahApps.Metro.SimpleChildWindow.resources
Update period has passed (set to: 1. 2. 2024 10:38:21)
Trying to resolve assembly: Banners.resources, Version=0.2.2.0, Culture=sk-SK, PublicKeyToken=43bb11ab0fe90350
The resource assembly will be skipped: Banners.resources
Trying to resolve assembly: Banners.resources, Version=0.2.2.0, Culture=sk-SK, PublicKeyToken=43bb11ab0fe90350
The resource assembly will be skipped: Banners.resources
Trying to resolve assembly: Banners.resources, Version=0.2.2.0, Culture=sk, PublicKeyToken=43bb11ab0fe90350
The resource assembly will be skipped: Banners.resources
Trying to resolve assembly: Banners.resources, Version=0.2.2.0, Culture=sk, PublicKeyToken=43bb11ab0fe90350
The resource assembly will be skipped: Banners.resources
Settings have changed: True
Storing and saving current settings
Saving settings
Profiles:
&lt;Predvolený profil&gt;
Vysoká kompresia (malý súbor)
Vysoká kvalita (veľký súbor)
JPEG (grafický súbor)
PDF/A (dlhodobá ochrana)
PNG (grafický súbor)
Vytlačiť po uložení
Zabezpečené PDF
TIFF (viacstránkový grafický súbor)
Updating settings snapshot
Settings have changed: False
Settings have changed: False
Settings have changed: False
Settings have not changed, skip saving.
Trying to resolve assembly: PDFCreator.Controller.resources, Version=5.1.2.5, Culture=sk-SK, PublicKeyToken=fc6825f92a0342e2
The resource assembly will be skipped: PDFCreator.Controller.resources
Trying to resolve assembly: PDFCreator.Controller.resources, Version=5.1.2.5, Culture=sk-SK, PublicKeyToken=fc6825f92a0342e2
The resource assembly will be skipped: PDFCreator.Controller.resources
Trying to resolve assembly: PDFCreator.Controller.resources, Version=5.1.2.5, Culture=sk, PublicKeyToken=fc6825f92a0342e2
The resource assembly will be skipped: PDFCreator.Controller.resources
Trying to resolve assembly: PDFCreator.Controller.resources, Version=5.1.2.5, Culture=sk, PublicKeyToken=fc6825f92a0342e2
The resource assembly will be skipped: PDFCreator.Controller.resources
New JobInfo: C:\Users\rusko\AppData\Local\Temp\PDFCreator\Spool\8e8fbde3-bdfe-4c43-ad02-452b2bfb1f6e\testPage.inf
DocumentTitle: PDFCreator Testpage
ClientComputer: DESKTOP-7K2TUOM
SessionId: 1
PrinterName: PDFCreator
JobCounter: 0
JobId: 1
Adding thread ProcessingThread
New PrintJob C:\Users\rusko\AppData\Local\Temp\PDFCreator\Spool\8e8fbde3-bdfe-4c43-ad02-452b2bfb1f6e\testPage.inf from Printer PDFCreator
Creating job workflow
Building Job from JobInfo
Profile: &lt;Predvolený profil&gt; (GUID DefaultGuid)
Running workflow
Starting conversion...
Number of copies from source files: 1
Number of pages from source files: 1
Starting PrintJobWindow
Trying to resolve assembly: Prism.Wpf.resources, Version=7.2.0.1422, Culture=sk-SK, PublicKeyToken=40ee6c3a2184dc59
The resource assembly will be skipped: Prism.Wpf.resources
Trying to resolve assembly: Prism.Wpf.resources, Version=7.2.0.1422, Culture=sk-SK, PublicKeyToken=40ee6c3a2184dc59
The resource assembly will be skipped: Prism.Wpf.resources
Trying to resolve assembly: Prism.Wpf.resources, Version=7.2.0.1422, Culture=sk, PublicKeyToken=40ee6c3a2184dc59
The resource assembly will be skipped: Prism.Wpf.resources
Trying to resolve assembly: Prism.Wpf.resources, Version=7.2.0.1422, Culture=sk, PublicKeyToken=40ee6c3a2184dc59
The resource assembly will be skipped: Prism.Wpf.resources
System.InvalidOperationException: Sequence contains no elements
Adding thread 
There was an error while processing the print jobs: System.InvalidOperationException: Sequence contains no elements
   at System.Linq.Enumerable.First[TSource](IEnumerable`1 source)
   at pdfforge.PDFCreator.UI.Presentation.Workflow.WorkflowNavigationHelper.GetRawModel(IRegion region, String navigationUri)
   at pdfforge.PDFCreator.UI.Presentation.Workflow.WorkflowNavigationHelper.GetValidatedViewModel(IRegion region, String navigationUri)
   at pdfforge.PDFCreator.UI.Presentation.Workflow.InteractiveWorkflowManager.&lt;Run&gt;d__13.MoveNext()
--- End of stack trace from previous location where exception was thrown ---
   at System.Runtime.ExceptionServices.ExceptionDispatchInfo.Throw()
   at System.Runtime.CompilerServices.TaskAwaiter.HandleNonSuccessAndDebuggerNotification(Task task)
   at pdfforge.PDFCreator.UI.Presentation.PrintJobShell.&lt;PrintJobShell_OnLoaded&gt;d__4.MoveNext()
--- End of stack trace from previous location where exception was thrown ---
   at System.Runtime.ExceptionServices.ExceptionDispatchInfo.Throw()
   at System.Windows.Threading.ExceptionWrapper.InternalRealCall(Delegate callback, Object args, Int32 numArgs)
   at System.Windows.Threading.ExceptionWrapper.TryCatchWhen(Object source, Delegate callback, Object args, Int32 numArgs, Delegate catchHandler)
   at System.Windows.Threading.DispatcherOperation.InvokeImpl()
   at MS.Internal.CulturePreservingExecutionContext.CallbackWrapper(Object obj)
   at System.Threading.ExecutionContext.RunInternal(ExecutionContext executionContext, ContextCallback callback, Object state, Boolean preserveSyncCtx)
   at System.Threading.ExecutionContext.Run(ExecutionContext executionContext, ContextCallback callback, Object state, Boolean preserveSyncCtx)
   at System.Threading.ExecutionContext.Run(ExecutionContext executionContext, ContextCallback callback, Object state)
   at MS.Internal.CulturePreservingExecutionContext.Run(CulturePreservingExecutionContext executionContext, ContextCallback callback, Object state)
   at System.Windows.Threading.DispatcherOperation.Invoke()
   at System.Windows.Threading.Dispatcher.ProcessQueue()
   at System.Windows.Threading.Dispatcher.WndProcHook(IntPtr hwnd, Int32 msg, IntPtr wParam, IntPtr lParam, Boolean&amp; handled)
   at MS.Win32.HwndWrapper.WndProc(IntPtr hwnd, Int32 msg, IntPtr wParam, IntPtr lParam, Boolean&amp; handled)
   at MS.Win32.HwndSubclass.DispatcherCallbackOperation(Object o)
   at System.Windows.Threading.ExceptionWrapper.InternalRealCall(Delegate callback, Object args, Int32 numArgs)
   at System.Windows.Threading.ExceptionWrapper.TryCatchWhen(Object source, Delegate callback, Object args, Int32 numArgs, Delegate catchHandler)
   at System.Windows.Threading.Dispatcher.LegacyInvokeImpl(DispatcherPriority priority, TimeSpan timeout, Delegate method, Object args, Int32 numArgs)
   at MS.Win32.HwndSubclass.SubclassWndProc(IntPtr hwnd, Int32 msg, IntPtr wParam, IntPtr lParam)
   at MS.Win32.UnsafeNativeMethods.DispatchMessage(MSG&amp; msg)
   at System.Windows.Threading.Dispatcher.PushFrameImpl(DispatcherFrame frame)
   at System.Windows.Window.ShowHelper(Object booleanBox)
   at System.Windows.Window.ShowDialog()
   at pdfforge.PDFCreator.Editions.EditionBase.ShellManager.ShowPrintJobShell(Job job)
   at pdfforge.PDFCreator.UI.Presentation.Workflow.InteractiveWorkflow.DoWorkflowWork(Job job)
   at pdfforge.PDFCreator.Core.Workflow.ConversionWorkflow.PrepareAndRun(Job job)
   at pdfforge.PDFCreator.Core.Workflow.ConversionWorkflow.RunWorkflow(Job job)
   at pdfforge.PDFCreator.Core.Workflow.JobInfoQueueManager.ProcessJob(JobInfo jobInfo)
   at pdfforge.PDFCreator.Core.Workflow.JobInfoQueueManager.ProcessJobs()
Uncaught exception, IsTerminating: True
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	Unable to open PDFCreator generated emails in Outlook Android
About 10 months ago I logged a problem with the Microsoft Outlook mobile support team as I was no longer able to open PDFCreator generated emails in Outlook Android. The PDFCreator emails can be opened with Outlook desktop and other mobile email apps just fine. Outlook mobile support has agreed it is a bug in Outlook Android, however have not comnitted to a fix timeframe. The Outlook mobile support team have identifed the problem and suggested PDFCreator could also make some changes to fix the problem as follows:
The "Date" format is not compliant with RFC 5322 and the "Attachment content-type" entry which is defined as "application/octet-stream" rather than "application/pdf", given the nature of the attachment.
Any changce this could be incorporated into an upcomming PDFCreator release?
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	Transfert architect 5 sur autre ordinateur
Bonjour, je détient un PDF5 Pro (license : NECUQ-MPYEK-CSTZR-UHXON-XXXXX) et je voudrais installer ce produit sur un autre ordinateur. Comment puis-je avoir le fichier d'installation ? Merci
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	Detection of scanner
hi all,
PDF version 9 doesn't recognise my printer/scanner while it worked fine in previous versions. Any idea how to solve the problem? please note that scanner is fine with HP smart.
Thansk in advance for the answer.
Merry Christmas and Happy New Year
Daniel
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	Method for text field to copy data automatically from another text field
Hi,
I'd like to know how to do the following:
When one text field is competed, another field copies that text automatically.
Im fairly new to PDF architect &amp; especially Javascript, but if someone could share the code and method that would work best it would be greatly appreciated.
It could be triggered by an event or button. Im open to ideas on that part.
Simplest solution would be best. Thanks!
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	GitHub PDF print
Very often I create PDF-files with PDFcreator from webpages for documentation purposes. From the resulting PDF I then can copy/paste text for sending it in a mail or ask somewhere a question.
I'm trying to do the same from URL at no luck. The PDF itself is ok and readable but when I copy some text from it I get weird characters like this:

I tried Chrome / Firefox, also in reader view, none give a decent result.
What's the reason for not being able to create a "normal" PDF from GitHub with PDFcreator? Does GitHub use special formatting? Is there a solution to overcome this and have a "normal" PDF from which copy/paste is possible?
The PDF from github (see URL above) is the first time ever giving that kind of copy/paste problem (see picture above). I can only conclude that somehow github is different. As said, the PDF itself looks ok, it's just copy/paste that is not ok. I tried several PDF-readers, always with the same result
            1 post - 1 participant
            Read full topic
	Blurry graphics
Good morning,
I use your program a lot to convert Excel graphs to PDF via a macro. In recent years, however, the graphs have all become blurry for me. The only solution is to do them one by one (and there are many).
I don't understand why this change.
I tried with various profiles, but nothing.
I wanted to buy the "professional" one, do you think things can change?
Do you have any advice for graphic designers?
Thanks
Dilly
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